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5 Affiliations

5.1 Introduction

Membership of an organization or participation in an event is a source of social

relations. In organizations and events, people gather because they have similar

tasks or interests and they are likely to interact. Members of a sports club, for

instance, share a preference for a particular sport and play with or against one

another. Directors and commissioners on the boards of a corporation are

collectively responsible for its financial success and meet regularly to discuss

business matters. Inspired by the sociology of Georg Simmel, groups of people

that gather around one or more organizations and events are called social circles.

In previous chapters, we studied direct relations among people, such as the

choice of friends, or among other social entities, e.g., trade relations between

countries. Note that we studied relations among actors of one kind: relations

between people or between organizations, but not between people and

organizations. Now, we will focus on the latter type of relations, which are called

affiliations. Data on affiliations can be obtained relatively easily and they are

very popular in data mining.

Affiliations are often institutional or ‘structural’, that is, forced by

circumstances. They are less personal and result from private choices to al lesser

degree than sentiments and friendship. Of course, membership oin a sports team

depends much more on a person’s preferences than detention in a particular

prison ward, but even the composition of sports teams depends on circumstances

and on decisions made by coaches and sports club authorities. Affiliations

express institutional arrangements and since institutions shape the structure of

society, networks of affiliations tell us a lot about society. People are often

affiliated to several organizations and events at the same time, so they belong to a

number of social circles, or, in other words, they are the intersection of many

social circles. Society may be seen as a fabric of intersecting social circles.

Although membership lists do not tell us exactly which people interact,

communicate, and like each other, we may assume that there is a fair chance that

they will. Moreover, joint membership in an organization often entails similarities

in other social domains. If, for example, people have chosen to become members

in (or have been admitted to) a particular golf club, they may well have similar

professions, interests, and social status. Different types of affiliations do not

overlap in a random manner: social circles usually contain people who are

clustered by affiliations to more than one type of organization. From the number

or intensity of shared events, we may infer the degree of similarity of people.

However, this argument can be reversed: organizations or events that share more



Exploratory Social Network Analysis with Pajek   W. de Nooy, A. Mrvar, V. Batagelj

92

members are also more close socially. A country club with many members from

the local business elite can be said to be part of the business sphere.

In this chapter, we present a technique to analyze networks of affiliations

which focuses on line values and we discuss three-dimensional displays of social

networks.

5.2 Example

In political science, economy, and sociology, much attention has been paid to the

composition of the boards of large corporations. Who are the directors of the

largest companies and, in particular, which people sit on the boards of several

companies? If a person is a member of the board of directors in two companies,

he (women have seldom been found in these positions) is a multiple director, who

creates an interlocking directorate or interlock between firms.

The network of interlocking directorates tells us something about the

organization of a business sector. It is assumed that interlocking directorates are

channels of communication between firms. In one board, a multiple director can

use the information acquired in another board. Information may or may not be

used to exercise power, depending on the role played by the director. If directors

are elected because of their social prestige within a community, they serve the

public relations of a firm, but they do not influence its policy: they fulfill a

symbolic role. However, multiple directors who have executive power may

coordinate decisions in several companies, thus controlling large sections of an

economy. Then, interlocking directorates are power lines.

In this chapter, we use a historical example: the corporate interlocks in

Scotland in the beginning of the twentieth century (1904-5). In the nineteenth

century, the industrial revolution brought Scotland railways and industrialization,

especially heavy industry and textile industry. The amount of capital needed for

these large scale undertakings exceeded the means of private families, so joint

stock companies were established, which could raise the required capital. Joint

stock companies are owned by the shareholders, who are represented by a board

of directors. This opens up the possibility of interlocking directorates. By the end

of the nineteenth century, joint stock companies had become the predominant

form of business enterprise at the expense of private family businesses. Families,

however, still exercised control through ownership and directorships.

The data are taken from the book The Anatomy of Scottish Capital by John

Scott and Michael Hughes. It lists the multiple directors of the 108 largest joint

stock companies in Scotland in 1904-5: 64 non-financial firms, 8 banks, 14

insurance companies, and 22 investment and property companies

(Scotland.net). The companies are classified according to industry type (see

Industrial_categories.clu): 1 - oil & mining, 2 - railway, 3 - engineering

& steel, 4 - electricity & chemicals, 5 - domestic products, 6 - banks, 7 -

insurance, and 8 - investment. In addition, there is a vector specifying the total

capital or deposits of the firms in 1,000 pound sterling (Capital.vec).
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We listed 136 multiple directors, but we should note that two multiple

directors (W.S. Fraser and C.D. Menzies) are affiliated with just one board so

they are not multiple directors in the strict sense. The data files are collected in

the project file Scotland.paj.

5.3 Two-mode and one-mode networks

By definition, affiliation networks consist of at least two sets of vertices such that

affiliations connect vertices from different sets only. There are usually two sets,

which are called actors and events, for example, directors (actors) and boards of

corporations (events). Affiliations connect directors to boards, not directors to

directors or boards to boards, at least not directly. Figure 1 shows a fragment of

the interlocking directorates network in Scotland: a set of directors (green) and

firms (yellow). Note that lines always connect a yellow and a green vertex, e.g.,

director J.S. Tait to the Union Bank of Scotland. This type of network is called a

two-mode network or a bipartite network, which is structurally different from the

one-mode networks, which we have analyzed thus far because all vertices can be

related in a one-mode network.

In a one-mode network, each vertex can be related to each other vertex.

In a two-mode network, vertices are divided into two sets and vertices can only

be related to vertices in the other subset.

Figure 1 - A fragment of the Sottish directorates network.

We can describe the two-mode network of Scottish directorships in the usual

manner by its number of vertices (108 firms and 136 multiple directors) and lines

(356 affiliations or board seats), the number of components (16 isolated firms

without multiple directors, three small components containing two firms, and one

large component), and its degree distribution. Recall that the degree of a vertex is

equal to the number of its neighbors if the network does not contain multiple lines

and loops. This is the case in the directorships network, so the degree of a firm

specifies the number of its multiple directors. This is known as the size of an

event. The degree of a director equals the number of boards he sits on, which is
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called the rate of participation of an actor. Have a look at Figure 1 and

determine the size of events and participation rates of its vertices.

In our description of a two-mode network, we must distinguish between

actors and events, because simple measures such as degree have different

meanings for actors and events. There are more complications: some structural

indices must be computed in a different way for two-mode networks. Consider,

for example, the concept of completeness, which we defined as the maximum

possible number of lines in a network (see Chapter 3). In a one-mode network,

this number is much higher than in a two-mode network because each vertex can

be related to all other vertices in a one-mode network but it can only be related to

part of the vertices in a two-mode network. As a consequence, the density of a

two-mode network, which is the actual number of lines divided by the maximum

possible number of lines, must be computed differently for one-mode and two-

mode networks.

Techniques to analyze one-mode networks cannot always be applied to two-

mode networks without modification or change of meaning. Special techniques

for two-mode networks are very complicated and fall outside the scope of this

book. So, what can we do? The solution commonly used, which we will follow, is

to change the two-mode network into a one-mode network, which can be

analyzed with standard techniques.

Figure 2 - One-mode network of firms created from the network in Figure 1.

We can create two one-mode networks from a two-mode network: a network of

interlocking events and a network of actors which share membership or

attendance to common events. Figure 2 shows the one-mode network of firms

(events) which is derived from the network in Figure 1. It is constructed in the

following way. Whenever two firms share a director in the two-mode network,

there is a line between them in the one-mode network. J.S. Tait, for instance,

creates a line between the Union Bank of Scotland and The Edinburgh Investment

Trust because he sits on the boards of both companies. Since he is also on the
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board of the National Guarantee and Suretyship Association, he is responsible for

lines between three firms. Each line can be labeled by his name. In addition, he

creates a loop for each of these firms. The number of loops incident with a vertex

shows the number of its neighbors in the two-mode network. In our example, it

shows the number of multiple directors on the board of a firm: the size of the

event. In short, the actors in the two-mode network become the lines and loops in

the one-mode network of events.

From Figure 2, it is clear that firms can be connected by multiple lines,

namely in the case that two firms share more than one director. The derived

network, therefore, usually is not a simple network. Since it may also contain

loops, you must take care when you interpret the degree of a vertex in a network

derived from a two-mode network.

Figure 3 - One-mode network of directors derived from Figure 1.

Multiple lines can be replaced by a single line to obtain a valued network with a

line value expressing the original number of lines between two vertices. Such a

line value is called a line multiplicity. Figure 3 shows the valued network of

directors (co-membership) which can be derived from the example in Figure 1.

Now, the events of the two-mode network are represented by lines and loops in

the one-mode network of actors. J.S. Tait meets W. Sanderson in board meetings

of two companies. We are confident that you can trace the firms which are

responsible for the lines in this network.

Although we stated that one-mode networks derived from two-mode networks

can be analyzed with standard techniques, there is a risk of interpreting the results

erroneously. A direct relation in a derived one-mode network is easy to interpret:

it indicates that two boards have common directors or that two directors meet at

one or more boards. Absence of a direct tie implies that two boards do not share a

director, e.g., Alliance Trust and Edinburgh Investment Trust in Figure 2, or that

two directors do not meet in a board, for instance, A. Whitton and J.S. Tait in

Figure 3.

The interpretation of subgroups consisting of three or more vertices is more

complicated in derived one-mode networks. Figure 2 contains three cliques of

size three. Two cliques are due to directorships of one person, e.g., P.W.

Campbell and J.S. Tait, but one clique is not: the clique of size three with

Scottish American Mortgage, Alliance Trust, and Scottish American Investment

exists thanks to the memberships of three directors (Campbell, Whitton, and
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Maitland). In a valued network, this difference is not visible because the multiple

lines labeled by names of directors are replaced by single lines with multiplicity

values. When interpreting a derived valued network, restrict your conclusions

about the number of shared persons (or events) to pairs of vertices. For

threesomes and larger sets of vertices you can only conclude that they share one

or more actors or events, but you do not know the actual number.

Application

Pajek has special facilities for two-mode networks. We advise to use the data

format for two-mode data, which is an ordinary list of vertices and list of edges

with the special feature that the list of vertices is sorted: the first part contains all

vertices which belong to one subset and the remainder lists the vertices of the

other subset. In our example (Scotland.net), vertices numbered 1 to 108 are

firms and 109 to 224 are multiple directors. The first line of the data file specifies

the total number of vertices and the number of vertices in the first subset, e.g.,

*Vertices 244 108. If Pajek opens a data file in this format, it automatically

creates a partition which distinguishes between the first subset of vertices (class

1) and the second (class 2). This partition is labeled Affiliation partition

in the Partition drop list

You need the affiliation partition to derive a one-mode network from the two-

mode network. The submenu Net>Transform contains several commands to

translate two-mode into one-mode networks. You can create a one-mode network

on each of the two subsets of vertices. By convention, vertices of the first subset

are called ‘rows’ and ‘columns’ refer to the second subset. These terms come

from matrix notation, which we will discuss in Chapter 12. The subsets are

defined by the affiliation partition. In our example, the first subset contains the

firms, so the Rows command in the 2-Mode to 1-Mode submenu will create a

network of firms, provided that the two-mode network and affiliation partition are

selected in the drop lists of the Main screen. The Columns command creates a

network of directors.

Check the option Include Loops before you derive a one-mode network if you

want to know the number of affiliations per vertex in the new network.

Depending on the subset you choose for induction, loops specify the participation

rate of actors or the size of events. When the option Multiple lines is checked, the

derived network will contain one line for each shared actor or event with labels of

the events or actors which create the lines. If this option is not checked, a valued

network without multiple lines is created with line values expressing line

multiplicity. Usually, you do not want loops or multiple lines in the one-mode

network, so we do not check these options now.

There is an easy way to display the distribution of line values in Pajek, for

example, line multiplicity in a derived one-mode network: execute the command

Line Values from the Info>Network submenu. In a dialog box, you may either

specify custom class boundaries or you may choose a number of classes of equal

width. To obtain classes of equal width, type a number preceded by a #-sign in

Net>Transform

>2-Mode to 1-Mode

>Rows,

Columns

Net>Transform

>2-Mode to 1-Mode

>Include Loops,

Multiple lines

Info>Network

>Line Values
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the dialog box. Usually, the number suggested by the dialog box serves the

purpose.

Table 1 - Line multiplicity in the one-mode network of firms.

Line Values Frequency Freq% CumFreq CumFreq%

(            ... 1.0000] 229 83.5766 229 83.5766

( 1.0000 ... 2.0000] 28 10.2190 257 93.7956

( 2.0000 ... 3.0000] 7 2.5547 264 96.3504

( 3.0000 ... 4.0000] 3 1.0949 267 97.4453

( 4.0000 ... 5.0000] 1 0.3650 268 97.8102

( 5.0000 ... 6.0000] 0 0.0000 268 97.8102

( 6.0000 ... 7.0000] 0 0.0000 268 97.8102

( 7.0000 ... 8.0000] 6 2.1898 274 100.0000

Total 274 100.0000

Table 1 lists the multiplicity of the lines in the one-mode network of Scottish

firms. The first class contains 229 lines with values up to and including one.

Since there are no lines with multiplicity less than one, this class contains all lines

with multiplicity one: the single lines. The next class contains lines with values

higher than one, up to and including lines with value two. We assume that you

will understand that all 28 lines in this class have multiplicity two; they refer to

pairs of firms interlocked by two directors.

You can use the affiliation partition, which distinguishes between the two

modes (actors and events), to select the vertices of one mode from a partition or

vector associated with the two-mode network. The standard techniques for

extracting one or more classes from one partition or vector according to another,

which we presented in Chapter 2, can be used to this end.

Imagine, for example, that we want to know the degree of the firms in the

two-mode network, which is equal to the number of their multiple directors (the

size of the events). We compute the degree in the usual manner with the

Degree>Input command in the Net>Partitions submenu. The partition created by

this command does not distinguish between the firms and the directors, so we

must extract the firms from it. We select the degree partition as the first partition

in the Partitions menu because we want to extract the firms from it. Next, we

select the affiliation partition as the second partition in this menu because it

identifies the firms within the network. Finally, we extract class 1 (the firms) of

the affiliation partition from the degree partition with the Second from First

command in the Partitions menu. Now, we can make a frequency distribution

(Info>Partition) of the degree of the firms. In the same way, we can translate

partitions belonging to a two-mode network to a one-mode network derived from

it.

5.4 M-slices

One-mode networks derived from two-mode affiliation networks are often rather

dense. They contain many cliques, so we can analyze the structure of overlapping

Net>Partitions

>Degree>Input

Partitions

>Extract Second from First
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cliques or complete subnetworks if we want to detect cohesive subgroups (see

Chapter 3, Section 3.6). In Chapter 12, additional techniques are presented which

are useful for analyzing dense networks. In the present chapter, however, we will

concentrate on a technique based on line multiplicity: m-slices.

Multiple lines are considered to be more important because they are less

personal and more institutional. From this point of view, we may define cohesive

subgroups on line multiplicity rather than on the number of neighbors. The larger

the number of interlocks between two firms, the stronger their tie, the more

similar or interdependent they are. In Figure 4, for instance, the four gray firms

share eight directors; they are connected by six lines of multiplicity eight (see

Table 1). These firms are connected much more tightly than other firms, which

are connected at a multiplicity level of five or less.

Figure 4 - m-slices in the network of Scottish firms (1904-5).

This brings us to the concept of an m-slice: a subnetwork defined by the

multiplicity or value of lines. In an m-slice, vertices are connected by lines of

multiplicity m or higher to at least one other vertex. This concept was introduced

by John Scott, who called it an m-core, but we prefer to rename it because we

reserve the term ‘core’ for a k-core.

An m-slice is a maximal subnetwork containing the lines with a multiplicity equal

to or greater than m and the vertices incident with these lines.

An m-slice is similar to a k-core in several respects. A trivial point of resemblance

concerns its notation. While a 2-core of a simple undirected network is a core in

which vertices are connected to at least two neighbors, vertices in a 2-slice are

connected by lines with multiplicity two or higher. Furthermore, m-slices are

nested like k-cores. In Figure 4, we manually circled the vertices in the m-slices.
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These contours show the nesting of cores: the (red) 3-slice is contained in the

(green) 2-slice, which is nested in the (yellow) 1-slice. The number of contours

which surround a vertex is equal to the multiplicity value defining the m-slice it

belongs to.

Finally, note that a entire m-slice does not need to be connected, e.g., the 2-

slice of the Scottish firms network contains several unconnected parts. Just like a

k-core, an m-slice does not necessarily identify one cohesive subgroup. If you

want to find the cohesive subgroups in a particular m-slice, that is, the vertices

which are connected by lines of a particular minimum multiplicity, remove all

lines with values lower than m and look for weak components. Each component

contains vertices which are directly or indirectly linked by ties of a particular

strength.

Figure 5 - 2-slice in the network of Scottish firms (1904-5).

Figure 5 shows the components within the 2-slice: several small components of

firms of one type (domestic products, railways, electricity, investments) and one

larger component consisting of a ‘knot’ of large firms dedicated to railways,

engineering, steel, mining, and chemicals, and a ‘tail’ of financial institutes:

banks, insurance and investment companies. In the large component, the wealthy

Caledonian Railway occupies a pivotal position. We may conclude that plural

interlocks interconnect financial organizations rather than that they link the
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financial sphere to the heavy industries or the production of consumer goods in

this historical example.

Application

In Pajek, there are several ways for producing the m-slices in a valued network. If

you want to obtain a particular m-slice, e.g., the 2-slice, we recommend to delete

all lines with line values below m with the Net>Transform>Remove>lines with

value>lower than command: enter the desired level of m, e.g., 2, in the dialog

box issued by this command. Next, identify all isolated vertices with a degree

partition (isolated vertices have zero degree) created with the command

Net>Partitions> Degree>Input, and remove them with the Operations>Extract

from Network> Partition command: extract classes one and higher in the degree

partition.

With the degree partition, you can also extract the non-isolated vertices from

the partition of industrial classes (Industrial_categories.clu) and from

the vector containing the capital or deposits of the firms (Capital.vec). Use the

Partitions>Extract Second from First and Vector>Extract Subvector commands

discussed in Chapter 2 (sections 2.4 and 2.5 respectively). If you draw the new

network, partition, and vector (command Draw>Draw-Partition-Vector) and

energize it, you obtain a sociogram similar to the one depicted in Figure 5.

If you just want to know the m-slices to which the vertices belong, you may

use the commands in the submenu Net>Partitions>Valued Core, provided that

the network does not contain multiple lines or loops. Make sure that the option

Use max instead of sum is checked in the submenu before you execute either the

First Threshold and Step or Selected Thresholds command, which are two

different ways to group continuous line values into classes. If you want m to

represent classes of equal width, choose the command First Threshold and Step

and choose Selected Thresholds otherwise. The latter command needs a vector for

input, which is a little bit complicated, so we will not discuss it here.

If you use the command First Threshold and Step, you must choose between

Input, Output, and All. By now, you will be familiar with these options and you

will know it is best to choose Input or Output when you are analyzing an

undirected network. In a dialog box, you must specify the first threshold, which is

the upper limit of the lowest class. Note that each class includes its upper limit.

The default threshold, e.g. 0, is the correct choice if the network may contain

isolated vertices. A second dialog box asks for the step value, which is the class

width. It is one by default and this is a good value for m-slices because it creates a

class for each consecutive multiplicity.

Now, Pajek creates a partition with class numbers corresponding to the

highest m-slice each vertex belongs to. In addition, Pajek reports a frequency

table with the distribution of vertices over m-slices (denoted by m). Note that

loops (if present) are taken into consideration in the computation, so remove them

from the network first, otherwise isolated vertices may be regarded as having one

or more neighbors.

Net>Transform>Remove

>lines with value>lower
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Net>Partitions>Degree

>Input

Operations>Extract

from Network>Partition

Partitions

>Extract Second from First

Vector>Extract Subvector

Draw

>Draw-Partition-Vector

Net>Partitions

>Valued Core
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Net>Partitions

>Valued Core

>First Threshold and Step
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The m-slices partition can be drawn in the usual way. Since the idea of m-

slices is that vertices with stronger ties are more similar, we recommend to use

line values when you energize a network of m-slices. Lines with high multiplicity

ought to be drawn shorter than lines with low multiplicity. In Chapter 4, we

already presented the relevant option (Options>Values of Lines>Similarities).

Tightly connected vertices in the double sense, viz. entertaining many lines and

lines with high values, will be located closely together, e.g., the four gray vertices

in Figure 4, which are the pink tea companies in Figure 5. These firms are a

clique and each pair of firms is connected by eight directors. Actually, eight men

sat on the boards of all four companies. No wonder that they are almost drawn on

top of each other.

Finally, Pajek offers a powerful tool to show m-slices interactively on the web

with the Export>SVG submenu. Select the command Nested Classes from the

submenu Line Values to obtain an HTML-file with a drawing of the network. If

you open this file in an internet browser with the SVG plug-in installed (see

Appendix 2 for details), you will see the sociogram and a set of checkboxes to its

right. Each checkbox  is associated with a class of lines, which you specified in a

dialog box. If you deselect a checkbox, all lines with values up to and including

the deselected class are removed from the picture as well as all vertices which are

isolated when the lines are removed. This allows you to view the lines and

vertices at different multiplicity levels interactively. The HTML-file m-

slices.htm on the CD-ROM offers an example.

Figure 6 - m-slices in the network of Scottish firms modeled as a terrain.

5.5 The third dimension

Contours around m-slices resemble elevation lines on a hiker’s map: crossing a

contour means that you go up or down one m-slice as if you are climbing or

descending a certain amount of meters in the mountains. Can we model the

network as a landscape in which the elevation of a point matches the value of its

m-slice? This can be done, as illustrated by Figure 6, but it involves techniques

[Draw screen] Options

>Values of Lines

>Similarities

Export>SVG

>Line Values

>Nested Classes
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from geography which are not available in Pajek. Although we cannot obtain such

a smooth picture easily, we can apply the principle of adding heights to points in

a plane.

In previous chapters, we alluded to the possibility of drawing networks in

three dimensions but we restricted ourselves to two dimensions. The third

dimension is called the z-axis, which points from the plane of the Draw screen

towards the person in front of the computer monitor. If we use the m-slice class

numbers of vertices as their scores on the z-axis, the highest m-slice peaks out of

the plane. If computer screens were flexible, a three-dimensional drawing of the

m-slices in the network of Scottish firms would change its surface to the

landscape of Figure 6 and we would be able to feel m-slices with our fingertips.

As it is, we have to be satisfied with a faint sensation of depth, which is

caused by the size of vertices and the darkness of vertex labels in a two-

dimensional drawing. Nearby vertices are drawn larger and distant vertex labels

are gray rather than black. When we rotate the network, we get a better view of

the ‘landscape’ of m-slices (Figure 7), which is clearly dominated by the gray

peak of the 8-slice.

Figure 7 - m-slices in three dimensions.



Exploratory Social Network Analysis with Pajek   W. de Nooy, A. Mrvar, V. Batagelj

103

The third dimension offers another opportunity to visualize social networks.

Instead of using a predetermined set of values as z-scores (heights), e.g., values of

m-slices, we can energize a network in three dimensions, allowing the Energy

procedure to locate vertices in a three-dimensional space in order to optimize the

length of lines. Sometimes, a third dimension helps to detect patterns, for instance

a 3D drawing of the Scottish firms networks separates the different red 3-slices

better than a two-dimensional drawing (Figure 9) but the results are often

disappointing. Our graphical devices can handle two-dimensional representations

much better than three-dimensional models.

Application

First, let us have a look at the coordinate system of Pajek (Figure 8). Imagine that

the light gray square is the Draw screen. As we have seen before, the x-value

defines the horizontal location of a vertex (from left to right) and its y-value

specifies the vertical position (from top to bottom). The z-value of a vertex

defines its protrusion from the background of the Draw screen. The arrows

indicate the direction of positive rotations around the axes.

Figure 8 - Coordinate system of Pajek.

You can ‘lift’ the m-slices out of the plane of the screen with the Layers menu in

the Draw screen. First, optimize the drawing using line values as similarities (see

previous section) to make sure that vertices in an m-slice are drawn closely

together. Also, make sure the m-slices partition is active and displayed in the

draw screen, otherwise the Layers menu is not available. Next, choose option 3D

from the Type of Layout submenu and the Layers menu will show a command

which displays the layers in the z direction. On execution of the In z direction

command, nothing seems to happen but if you take a closer look, you will see that

some vertices are drawn larger than others and some vertex labels are gray

instead of black. You are looking at the ‘peaks’ from above, which does not give

much sense of relief.

When you rotate the structure, peaks and lowlands are more apparent. Toggle

the ScrollBar On/Off option in the Options menu to add two scrollbars to the top

left of the Draw screen (see Figure 7). Press the buttons on the vertical scroll bar

to rotate the network around the x-axis, which will raise or lower the peaks, and

continue until you are satisfied with your view. Now you can see that the gray 8-

Layers>Type of Layout

Layers>In z direction

Options

>ScrollBar On/Off

Z

Y

X0 1

1

1
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slice is towering high above the rest of the network. If the Draw screen is active,

you can use the x, y, and z keys on your keyboard to spin the network around the

x, y, and z axis respectively. Use capitals X, Y, and Z for rotation in the opposite

direction.

You can also rotate the three-dimensional structure in any direction you wish

with the Spin menu, but this is slightly more complicated because you have to

choose the axis of rotation (command Normal) and the angle of rotation, which

you must enter in a dialog box displayed by the Spin around command. When you

ask for a rotation over 360 degrees (or just press s or S if the Draw screen is

active), you will see the network revolve for your eyes. This allows you to inspect

the network from all angles.

Three-dimensional optimization is accomplished with the command 3D in the

Layout>Energy>Fruchterman Reingold submenu. Figure 9 offers a view of the

main component of Scottish firms after three-dimensional optimization. The

colors of the vertices indicate their m-slice. Now, we can see that there are several

small (red) 3-slices rather than one large core.

Figure 9 - VRML model of m-slices in the largest component of Scottish firms.

Figure 9 is a Virtual Reality Markup Language (VRML) model, which can be

displayed and manipulated by an internet browser provided that a special plug-in

is installed (for details see Appendix 2). You can rotate and move through the

structure as if it is part of a video game, but you need a fast computer and

Spin menu

Layout>Energy

> Fruchterman Reingold

>3D

Export>VRML
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graphics card for smooth operations. The file m-slice.wrl, which was created

by Pajek with the Export>VRML command, contains the model shown here.

5.6 Summary

Affiliation networks are typically two-mode networks, in which persons are

related to organizations. The structure of these networks may be analyzed with

standard network techniques, but several structural concepts have to be redefined

or must be interpreted differently when applied to two-mode networks. Therefore,

network analysts usually focus on the one-mode person-by-person or

organization-by-organization network which can be derived from a two-mode

affiliation network.

Derived one-mode networks tend to be rather dense, since all people affiliated

to one organization are interrelated in the derived network of persons and all

organizations which share a particular person are completely connected in the

derived network of organizations. Researchers apply the techniques of

overlapping cliques and m-slices to networks derived from affiliations.

Overlapping cliques identify relatively dense sections of the network and m-slices

identify clusters of persons or organizations which are related by multiple lines,

e.g., firms which share a certain number of directors.

Finally, this chapter introduces three-dimensional displays. We can use the

third dimension to represent predetermined values by layers, e.g., the multiplicity

level of m-slices, which turns a sociogram into a landscape, or we can use all

three dimensions to energize a network. In subsequent chapters, we will

encounter more applications of the third dimension but it should be noted that

two-dimensional sociograms are often easier to interpret.

5.7 Exercises

1 Add the names of the firms to the lines of the one-mode network of directors

in Figure 3 (Section 5.3).

2 Which of the following statements is correct? Justify your choice.

a Each affiliation network is a two-mode network.

b Each two-mode network is an affiliation network.

3 In Figure 4 (Section 5.4), what is the multiplicity of the relation between the

two pink vertices?

a we do not know

b 4

c 5

d 5 or higher
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4 The sociogram below depicts a one-mode network of firms derived from

affiliations between multiple directors and firms. Which of the following

interpretations can be incorrect?

a Three directors sit on the boards of v1 and v5 simultaneously.

b No director sits on all four boards of firms v2, v3, v5, and v6.

c Two directors sit on the boards of v3, v4, and v7 simultaneously.

d No director sits on the boards of v1 and v4 simultaneously.

5 Add contours of m-slices to the sociogram of Exercise 4.

6 Create a three-dimensional energized drawing of the information network in

San Juan Sur, which you analyzed in the assignment of Chapter 3

(SanJuanSur_deathmessage.net). Which family-friendship groupings

(SanJuanSur_deathmessage.clu) are nicely clustered in this image?

5.8 Assignment

In Hollywood, composers of soundtracks work on a freelance basis. For each

movie, a producer hires a composer and negotiates a fee. The earnings of

composers is highly skewed: a handful of composers earn a lot whereas most of

them have moderate or low revenues. This is characteristic of artistic labor

markets.

Why do some composers earn much more money than their colleagues in

Hollywood? Let us assume that there are two hypotheses:

1. A successful composer works for the same producer(s) on a regular basis

whereas less successful composers do not.

2. The most successful composers all work for the top producers who are

responsible for the most expensive movies.

The network Movies.net contains the collaboration of 40 composers and the 62

producers who produced a minimum of five movies in Hollywood, 1964-1976.

This is a 2-mode network: a line between a composer and a producer indicates

that the former created the soundtrack for the movie produced by the latter. The

line values indicate the number of movies by one producer for which the

composer created the music in the period 1964-1976. The partition

Movies_top_composers.clu identifies the five top composers each of whom

earned 1.5% or more of the total income of Hollywood movie score composers in

the 1960s and 1970s.

Analyze the 2-mode network in order to test hypothesis 1. Then, create a 1-

mode network of composers and see whether it corroborates or falsifies

hypothesis 2.
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5.9 Further Reading

•  Georg Simmel stated his ideas about social circles in Soziologie.

Untersuchungen über die Formen der Vergesellschaftung (Berlin: Duncker &

Humblot, 1908), which was translated by Kurt H. Wolff as The Sociology of

Georg Simmel (New York: The Free Press, 1950). Charles Kadushin used this

concept and adapted it to network analysis in his book The American

Intellectual Elite (Boston: Little, Brown and Company, 1974), using the

technique of overlapping cliques.

•  In the paper ‘Analysing interlocking directorates: theory and methods’,

published in the journal Social Networks (vol. 1 (1979) issue 4, p. 1-36),

Meindert Fennema and Huibert Schijf survey research on interlocking

directorates. Our example is taken from John Scott & Michael Hughes, The

anatomy of Scottish capital: Scottish companies and Scottish capital, 1900-

1979 (London: Croom Helm, 1980).

•  Stanley Wasserman and Katherine Faust discuss affiliation networks and

some advanced techniques in  Chapter 8 of their book Social Network

Analysis: Methods and Applications (Cambridge: Cambridge University

Press, 1994).

•  The data of the assignment are taken from Robert R. Faulkner, Music on

Demand. Composers and Careers in the Hollywood Film Industry (New

Brunswick: Transaction Books, 1983).

5.10 Answers

1 The sociogram should look like this (do not forget the loops!):

2 Answer a is correct, since affiliations are relations between people and

organizations or events, there must be two subsets which cannot be linked

internally. Heterosexual love relations constitute a two-mode network but not

an affiliation network, so answer b is not correct.

3 Answer c is correct. There are exactly five contours around the pink vertices,

so their multiplicity level is five.
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4 Interpretation c can be incorrect since it is possible that firms v3 and v4 share

other directors than firms v3 and v7 and firms v7 and v4. The other

interpretations can be correct.

5 Your answer should look like the sociogram below. Do not forget to draw

two contours around the 3-slice (left) and to include a contour for the 1-slice,

that is, the component, otherwise the level of multiplicity does not

correspond to the number of contours.

6 Energize the network with Fruchterman Reingold>3D and spin it around.

You will see that all family-friendship groupings are clustered quite well in

the three-dimensional model, with the exception of the light green family-

friendship grouping consisting of families f5, f14, f17, f25, f58, and f69,

which are scattered in the middle of the sphere.
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